
Introduction

Welcome to OffLine, the disk manager— we believe to be the complete solution to disk and file 
management.

OffLine is unique among Macintosh disk utilities. Unlike other utilities, it was designed to keep 
track of unmounted — or offline — disks. This means that, once the program knows about your 
disks, it can perform all of its functions without requiring you to mount them.

OffLine keeps track of your disk files in its own database, or catalog, which resides on your hard 
drive. The first time you launch OffLine, it creates and opens a catalog called “OffLine™ 
Catalog” in the folder from which you launched OffLine. The name and location of this catalog 
is “remembered” between sessions, so it is always opened automatically when you launch 
OffLine.

If you wish, you may create and use additional catalogs, and switch among them at will. At any 
given time, however, only one catalog can be active.

The program’s functions all access the active catalog automatically, and are based on four 
components of the program, called “engines”:

The Catalog Engine

While traditional databases require you to enter information, OffLine does this automatically. 
Scanning (cataloging) a disk (i.e., getting its information into the catalog) is as simple as 
inserting it into the disk drive (in the case of floppies and zip cartridges) or clicking a button to 
select a disk on your desktop. All the information about the disk and its files is quickly stored in 
the catalog. If the disk is a floppy or zip cartridge, it is ejected, whereupon you may insert the 
next disk to be cataloged. This can be repeated as many times as you like, whenever you like. If 
you have attached a comment to a file using Finder’s Get Info command, then OffLine will 
retrieve it, and attach it to the file’s entry in your catalog.

When cataloging files, OffLine recognizes and performs special processing on StuffIt™ 
(including the Classic and Deluxe versions), Compact Pro™, and AppleLink™    archives. The 
catalog engine automatically extracts information about each file in an archive, making a 
separate catalog entry for each. Similarly, the catalog engine includes intelligent support for files 
compressed by DiskDoubler™.

The Search Engine

Once your disks have been cataloged, you can locate any file or group of files with ease. The 
search engine offers an extremely flexible array of search options, ranging from simple to 
sophisticated. When OffLine has found what you were looking for, it tells you all about each file,
and — most importantly — on what disk each file is located.

OffLine provides two levels, or methods, for searching the catalog: Basic and Advanced. The 



basic search method allows you to find any file, or group of files, by specifying a disk and/or 
scanning the catalog for file names that contain a search string that you provide. You can further 
restrict your search to files created by a particular application. OffLine lists all the files that 
match your search criteria. A single click on any of the files found reveals its full path name, size,
creation date, modification date or version number, Finder label (under System 7.0 or later), and 
the name of the application that created it. If you click on a file that is contained in a StuffIt, 
Compact Pro, or AppleLink archive, the name and location of that archive is displayed.

The Advanced search method was designed for users who are familiar with Macintosh file 
signatures (types and creators), and who need the flexibility to conduct highly sophisticated 
searches of the catalog. This search method allows you to search on any combination of name, 
type, creator, and Finder label (System 7.0 or later), and displays signature information about the 
files that are found.

The Print Engine

Even when you know what disk to look for in your collection, finding a specific disk can be 
time-consuming, especially if your disk labels are out of date, inconsistent, or even non-existent. 
OffLine’s print engine offers a simple and elegant solution, by printing clear, professional-
looking floppy disk labels on standard label sheets designed for laser and inkjet printers.

If you’re a real stickler for organization, and want the ability to physically locate a disk fast, then
you will want to take advantage of OffLine’s automatic numbering feature. When a disk is 
cataloged, OffLine assigns it a unique serial number. When you print disk labels for floppy disks,
you can elect to have the serial numbers printed on the labels, so you can physically file your 
disks by number. This makes locating a desired disk quick and effortless.

The Export Engine

Finally, we recognize that information is a valuable resource, and that we cannot possibly 
anticipate all the creative uses to which you may want to put this information. So we made it 
very easy to export the contents of the catalog for use in virtually any other application — even 
those on non-Macintosh computers.

What You Need

Software Requirements

OffLine requires System version 6.0.5 or later, and is System 7 and MacOS8 friendly, offering a 
number of features that are available only if you are running System 7.0 or later.

OffLine supports Balloon Help™ under System 7 or MacOS8. To get help, simply turn on 
Balloon Help and pass the cursor over an object on the screen.

Hardware Requirements



OffLine will run on Macintosh Plus or later model    computers with a hard disk. Label printing 
requires a page printer (laser or inkjet) that supports either QuickDraw or PostScript.

Other Requirements

If you wish to print floppy disk labels, you’ll need    sheet-fed adhesive labels (Avery # 5196 or 
equivalent). These are available from many computer and office supply dealers.

Getting Started

Using OffLine

The first time you launch OffLine, it creates and opens a catalog named “OffLine™ Catalog” in 
the folder from which you launched the program. When you quit the program, OffLine saves the 
name and location of the catalog in a document named “OffLine Prefs” in a folder named 
“Preferences” in your System folder. Therefore, each time you launch the program, it opens the 
most recently used catalog.

Whenever you launch OffLine, its main window appears, containing information about the 
catalog. Because your catalog will initially be empty, the first thing to do is to catalog one or 
more disks.

Creating Disk Catalogs

Choose Scan Disks… from the File menu. OffLine’s “Scan Disks” dialog box appears. To 
catalog a floppy disk or zip cartridge, simply insert it into the drive. Within a few seconds, 
OffLine will mount the disk, add it to the catalog, and eject the disk. To catalog a group of disks, 
simply insert them, one after another.

 



o catalog any other disk on your desktop, click the Drive button, until you see the disk you want, 
then click the Scan Disk button.

Don’t worry if you’re not sure whether a disk has already been cataloged. When OffLine 
determines that a disk is already in the catalog, it refreshes the catalog, removing references to 
files that are no longer on the disk, adding any new files, and updating dates and sizes, as 
required.

OffLine “knows” whether a disk has been previously cataloged by comparing not only its name, 
but also its initialization date, to those in the catalog. If you insert a disk that has never been 
cataloged — but has the same name as a disk that has been cataloged — then OffLine will alert 
you, and suggest that you use the Rename checkbox to eliminate the duplication.

For inquiring minds, here’s a description of the check boxes,    buttons, and messages.

The “Serial number” popup menu allows you to control how serial numbers will be assigned to 
new disks in the catalog. You can choose:
•        “Next sequential,” which tells OffLine to assign a number one greater than the highest serial
number in the catalog.
•        “First available,” which assigns the lowest available serial number. This is useful if you 
have uncatalogued a disk, and wish to re-use its serial number.
•        Or, if there are gaps in the serial numbers (because you have uncatalogued one or more 
disks), you can choose a particular serial number from among those that are unused.

Tell OffLine what kind of disk is being scanned using the “Disk Type” popup menu.    This will 
be useful later when searching for a particular file, and want to know what kind of disk it is on.

By default, the Auto-Catalog option is checked. This means that OffLine will mount, catalog, 
and eject a floppy disk or zip cartridge as soon as you insert it in the drive. If this box is 
unchecked, however, the disk will be mounted, and its name will be displayed in the upper-left 
corner of the dialog — but the cataloging will not begin until you click the Scan Disk button.

There are two reasons why you might want to uncheck the Auto-Catalog… box. First, you have 
the opportunity to change your mind if you decide that you don’t want a particular floppy or zip 



cataloged: Simply click the Eject button to remove the disk without cataloging it.

Second, cataloging disks provides a good opportunity to think more systematically about how 
you name your disks. You may find, once a disk has been mounted, that the disk’s name is 
confusing or obsolete. Clicking the Rename disk… box displays a text box in which you can 
type a new name for the disk. The name you enter will be used to rename the disk before it is 
cataloged.

The Rename disk… check box is disabled if the disk you inserted is locked. If you wish to 
rename a locked disk, eject the disk, unlock it, then insert it again.

The Ignore system files box is normally checked. This option acts as a filter that prevents 
common Macintosh system files (e.g., “Desktop”, “Finder”, “System”) from being cataloged. If 
you want system files on your disks to be cataloged, click the box to uncheck it.

The Status area displays informational messages. If no drive has been selected, the message 
reads “Waiting for disk.”    During the period in which a disk is being cataloged, the message 
reads “Cataloging”, then “Saving entries”.

Once a disk has been cataloged, the message tells you the unique serial number that OffLine has 
assigned to the disk. This is the number that will be printed on the disk label if you choose that 
option (see Printing Labels, below).

Using the Search Engine

The appearance and operation of the Search window depends on your choice of search method. 
At any given time, you can use either the Basic Search or the Advanced Search method by 
selecting it from the Options menu.

Basic Search Method

The basic Search window consists of several sections. Counter-clockwise from the top, they are:

• Request Area (top section)
•
Disk List (left middle)
•
Info Area (left bottom)
•
Results List (right bottom)

 



equest Area

The request area, on top, is where you define your search criteria. You can elect whether to 
search for files on a particular disk or on all disks. You can limit the search to files in the catalog 
whose names match a particular string of characters, called a search string. You can also restrict 
your search to those files created by a particular application, by selecting the desired application 
from the popup menu labeled “Created by.”

The popup menu below “Name” extends the power of string searches by allowing you to control 
how strings are matched. This menu, which applies only when you specify a search string, 
contains the following choices:

•
Contains — Catalog entries whose names contain the search string will be found
•
Starts with — Catalog entries whose names begin with the search string will be found
•
Ends with — Catalog entries whose names end with the search string will be found
•
Equals — Catalog entries whose names exactly match the search string will be found

The string matching method defaults to Contains. Regardless of which method you use, case is 
not significant: “July” and “JULY” are treated as matches.

The checkbox labeled Include folders allows you to extend the scope of a string search to folders
and archives as well as files. For example, suppose you type “July” as a search string. If the 



checkbox is not checked, then OffLine will find all files whose names match “July” (assuming 
they match any other criteria you may have specified). However, when the Include folders 
checkbox is checked, OffLine will also find files within folders and archives whose names match
“July,” even if the file names themselves don’t match the search string.

The checkbox labeled Include comments allows you to extend the scope of a string search to 
comments attached to files, as well as the files themselves. For example, suppose you type 
“Apple” as a search string. If this checkbox is checked, then OffLine will find not only file names
that match, but also files whose comments contain “Apple.” 

The checkbox labeled Selected disk only allows you to decide whether your search will cover the
entire catalog, or just those entries on a selected disk. If you know which disk contains the files 
you are looking for, then select the disk in the Disk List, and check the box. The search will be 
much faster.

Disk List

Disk names are sorted alphabetically. To change the sort order, use the “Sort by” popup menu. 

Whenever you select a disk from the Disk List, information about the selected disk is displayed 
in the Info area.

You can browse the entire contents of a disk by double-clicking or option-clicking a disk in the 
Disk List. A dialog box will appear containing a graphical view of the folders and files on the 
disk. If there are any archives, then each will be represented by the icon belonging to the 
application that created it (i.e., StuffIt, Compact Pro, or AppleLink), and its component files will 
appear below. Click on any file to see information about it.

If, for some reason, you wish to uncatalog a disk, simply click on the disk icon in the Info Area 
and drag it to OffLine’s trash can. This action removes information about the disk from the 
catalog, but has no effect on the disk itself. Note that the serial number assigned to the disk will 
never again be used in the active catalog, even if you recatalog the same disk at a later time.

Results List

After clicking the Search button, the Results List is filled with all the files that matched your 
request, together with the names of the disks on which they are found. Clicking on the name of a 
file in the Results List displays information about that file.

If you click on a file name, then a File Info icon appears in right side of the Info area. Click on 
this icon to attach a comment (up to 200 characters) to that file’s catalog entry, or to view and 
edit an existing comment. Double-clicking on a file name has the same effect.

It’s easy to tell whether a file has an existing comment. Files with attached comments are 
displayed in boldface type.



The box surrounding the “File Name” column heading indicates that the results list is sorted by 
file name. To view the list sorted by disk name, click on the “Disk” column heading.

If you want to save the results of your search for later perusal, or for use in another application, 
click the Export button. The format in which your search results are saved is determined by your 
choice in the “Export preferences” dialog, accessed from the Edit menu (see Export Preferences, 
below).

To illustrate a string search, you could type the word “ideas” in the text box (top center), and 
click the Search button.

The Results List shows all the files in the catalog whose names contain the string “ideas”. Click 
on any item in the file list, and its attributes appear in the Info area below. If the selected file is a 
program (application, system extension, etc.) that contains a version number, then the version 
number will be displayed instead of a modification date. If you are running System Software 7.0 
or later, then the file’s label (as assigned in the Finder) will appear.

When performing a search, you can also narrow the search request to find only those files created
by a particular application. To find all HyperCard documents on all the cataloged disks, make 
sure the checkbox labeled “Selected disk only” is not checked (so that the search is not limited to
a single disk), then Select “HyperCard” from the “Created by” popup menu.

Whenever you catalog a disk containing an application previously unknown to OffLine, that 
application is permanently added to the “Created by” popup menu.

Advanced Search Method

If you use OffLine’s Advanced Search Method, you will see more popup menus in the Search 
window, and additional file information displayed in the Info Area.

 

he popups on the right allow you to restrict your search to files whose signatures (types and 
creators) match what you select from the menus.

If you are running System 7.0 or later, you can use the Labels popup menu to further restrict your
search to files having a particular Finder label.

Note what happens, for example, if you limit your search to those files whose type is “STAK” 
and whose creator is “WILD” (these comprise the signature for all HyperCard stacks). After 



clicking on the Search button, the Results list is filled with all the HyperCard stacks in the 
catalog.

Files contained in a StuffIt™, Compact Pro™, or AppleLink™    archive are marked with “»”. If 
you click on one of these files, then the archive’s name (instead of the file’s folder path) is 
displayed in the Info area. Files that have been compressed by DiskDoubler™ have “(DD)” 
appended to the file’s description in the File Info area.

You can combine different restrictions in your search request. If you enter “stack” as a search 
string, and choose “STAK” and “WILD” with the signature popups, then all HyperCard stacks 
whose names contain the search string are displayed.

Similarly, you could restrict your search to all files having a particular signature and residing on 
a particular disk. Simply select a disk by clicking in the Disk List, check the check box above the
Disk List, and choose the signature from the popup menus.

Whenever you catalog a disk containing an application previously unknown to OffLine, that 
application’s file type and creator are permanently added to the Type and Creator popup menus.

Adding and Editing Comments

 

henever file names appear in the file list, you can annotate any individual file with a free-form 
comment. Either select a file, then click on the File Info icon, or double-click on the name of a 
file. A comment dialog box appears. Type any comment up to 200 characters, just as you would 
in Finder’s Get Info box. If you click on the OK button, the comment will be permanently saved 
in the active catalog. 

When you perform a search, and file names appear in the file list, you can tell at a glance which 
files have comments attached to them. Files with comments are displayed in boldfaced text. If 
you double-click on a file that already has a comment, the comment will be displayed, and you 
can edit it if you wish.



To search for files whose comments contain a particular string, check the “Include comments” 
checkbox.

Tips & Tricks in the Search Window

To get an instant look at statistics about the active catalog, option-press the window’s title bar. As
long as you hold the mouse button down, catalog statistics will appear in the File Info area at the 
bottom of the window. For more complete information, choose Statistics… from the File menu.

Both the Disk List and the Results List support auto-scrolling. Instead of using the scroll bars to 
move through a list, you can press and hold the mouse button as you move the cursor toward the 
top or bottom of a list. When the cursor reaches the top or bottom, the list will scroll 
automatically. If your keyboard has arrow keys, then these will also scroll the lists.

Double-click or option-click on a disk name to browse the contents of a disk. This opens the 
browse window, which contains a Finder-like view of all the items on the disk. To expand a 
folder, just click on its arrow. To collapse a folder, click on its arrow again.

Double-click on a file name to add or edit a comment attached to the file. File names displayed in
boldfaced text have comments attached to them.

Sort the Disk List by free space, to help you learn which of your disks has enough room to 
accommodate a particular file or folder.

To remove a disk from the catalog, select it in the Disk List, then drag its icon (in the Info area) 
to OffLine’s trash.

If your catalog is very large (say, over 10,000 files), and you find that searching is getting slow, 
consider creating new catalogs, and dividing your disks among them in a way that makes sense 
to you.

When you perform a string search, pop up the string search menu to gain further control over 
how strings are matched.

If you know which disk contains the document(s) for which you’re searching, then select that 
disk and check the “Selected disk only” checkbox. The search will be completed much faster.

Available memory places limitations on the number of files OffLine can display in the Results 
List. If your catalog is large, and you perform a very broad search (e.g., all files that contain the 
letter ”a”), there may be more matching entries than can be displayed, and the following alert 
will appear:

This often means that you cast too broad a net in your search request. If you click Cancel, you 
can try again with more specific search criteria.



If you really want to find all the files that match your request, then click ”Export the matches,” 
and OffLine will direct its report of all matching files to a document that you can peruse and 
print with any word processor, spreadsheet, or database management system. The format of this 
report is determined by your choice of export format (choose Export preferences… from the Edit
menu).


